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 Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the 

operation of semiconductor products and application examples. You are fully responsible for the incorporation of these 
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for 
any losses incurred by you or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas 
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever 
for any damages incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property 
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in 
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other 
intellectual property rights of Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or 
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such 
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High 
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, 
as indicated below. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio 
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial 
robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster 
systems; anticrime systems; and safety equipment etc. 

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a 
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may 
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality 
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas 
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable 
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for 
which the product is not intended by Renesas Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas 
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage 
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no 
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified 
ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products 
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use 
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to 
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire 
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including 
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or 
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please 
evaluate the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all 
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, 
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your 
noncompliance with applicable laws and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not 
use Renesas Electronics products or technology described in this document for any purpose relating to military 
applications or use by the military, including but not limited to the development of weapons of mass destruction. When 
exporting the Renesas Electronics products or technology described in this document, you should comply with the 
applicable export control laws and regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or 
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set 
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as 
a result of unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of 
Renesas Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its 
majority owned subsidiaries. 
(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 

(2012.4) 



 

 

Disclaimer 
 
By using this Renesas Promotional Board (RPB), the user accepts the following terms: 
 

The RPB is not guaranteed to be error free, and the entire risk as to the results and performance of the RPB is 
assumed by the User. The RPB is provided by Renesas on an “as is” basis without warranty of any kind whether 
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular 
purpose, title and non-infringement of intellectual property rights with regard to the RPB. Renesas expressly 
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, 
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall 
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other 
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RPB, even 
if Renesas or its affiliates have been advised of the possibility of such damages.  

 
 
 
Precautions 
 
The following precautions should be observed when operating any RPB product: 
 

 

This Renesas Promotional Board is only intended for use in a laboratory environment under ambient temperature and 
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use 
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection 
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.  
 
The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment causes harmful interference to radio or television reception, which can be determined by turning the 
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;  

 

• ensure attached cables do not lie across the equipment  

• reorient the receiving antenna  

• increase the distance between the equipment and the receiver  

• connect the equipment into an outlet on a circuit different from that which the receiver is connected  

• power down the equipment when not in use  

• consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever 
possible shielded interface cables are used.  

 
The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the 
following measures be undertaken;  
 

• The user is advised that mobile phones should not be used within 10m of the product when in use.  

• The user is advised to take ESD precautions when handling the equipment.  
 
The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the 
regulatory standards for an end product. 



 

 

How to Use This Manual 

1.    Purpose and Target Readers 
 
This manual is designed to provide the user with an understanding of the RPB hardware functionality, and 
electrical characteristics. It is intended for users evaluating this microcontroller platform and using this 
promotional board. 
 
The manual comprises of an overview of the capabilities of the product, but does not intend to be a guide to 
embedded programming or hardware design. 
 
Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body 
of the text, at the end of each section, and in the Usage Notes section. 

 
 
The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of 
the manual for details. 

 
The following documents apply to the RX111 Group and this board. Make sure to refer to the latest versions of 
these documents. The newest versions of the documents listed may be obtained from the Renesas 
Electronics Web site. 
 

Document Type Description Document Title Document No. 
Tutorial Manual Describes the RPB hardware, sample software and 

capabilities.  
RPBRX111 Tutorial 
Manual 

R20UT2699EG 

Quick Start Guide Provides simple instructions to setup the RPB and 
run the first sample, on a single A4 sheet. 

RPBRX111 Quick 
Start Guide 

R20UT2700EG 

Design Manual Layout diagrams and Bill of Materials (BoM) for the 
RPB.  

RPBRX111 Design 
Manual 

R20UT2698EG 

Schematics Full detail circuit schematics of the RPB. RPBRX111 
Schematics 

R20UT2697EG 

Hardware Manual Provides technical details of the RX111 
microcontroller. 

RX111 Group 
Hardware Manual 

R01UH0365EJ 

 



 

 

2.    List of Abbreviations and Acronyms  
 
 

Abbreviation Full Form 
ADC Analog-to-Digital Converter 
EMC Electromagnetic Compatibility 
ESD Electrostatic Discharge 
GUI Graphical User Interface 
IRQ Interrupt Request 
LED Light Emitting Diode 
MCU Micro-controller Unit 
MOSFET Metal Oxide Semiconductor Field Effect Transistor 
n/a Not applicable 

NC Not connected 

J-Link OB J-Link On-board debugger 
PC Personal Computer 
PLL Phase Locked Loop 
ROM Read Only Memory 
RPB Renesas Promotional Board 
RSK Renesas Starter Kit 
UART Universal Asynchronous Receiver/Transmitter 
USB Universal Serial Bus 
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1.   Overview 

1.1 Purpose 
 
This RPB is a promotional board for Renesas microcontrollers. This manual describes the technical details of 
the RPB hardware, how to get started debugging and analysing the sample code and to use the 
demonstration GUI to evaluate the low power capabilities of the device. 
 

1.2 Features 
 
This RPB provides the following features: 
• Renesas microcontroller programming 
• User code debugging 
• User circuitry such as switches, LEDs and a potentiometer 
• USB Host/Function connectivity 
• Board-wide low power design for energy harvesting applications 
• MCU current measurement 

 

This product is not intended or supported for user solution development, and is designed solely for demonstration and 
evaluation. A Renesas Starter Kit (RSK) for the RX111 is available from your Renesas distributor. 

 

1.3 Package Contents 
 
• MCU current measurement 
• YRPBRX111 Board 
• USB Type A / Mini-B cable 
• Potentiometer shaft to adjust the potentiometer voltage 
• Mini DVD containing all the software, tools and documentation needed to quickly start evaluating the 

product. 
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2.   Hardware Components 

Figure 2-1 below shows the top and bottom component layouts of the board.  
 

Potentiometer User Switches

USB Host

User LEDs

USB Function

CN3 CN4

CN6CN5CN7

RX111

Pmod

Reset Switch

Supercapacitor

J-Link LED

RX621
J-Link

J-Link USB

E1 Connector

Expansion Headers
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Figure 2-1 Board component layout 

 
Component placement diagrams and the circuit routing can be found in the Design Manual. 
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2.1 User Switches, Potentiometer and LEDs 
 
Two user switches (SW1 and SW2) and a potentiometer (RV1) are provided for direct user input to the board. 
The switches are connected to interrupt (IRQ) pins and the potentiometer to an ADC input on the RX111 
device and are used to control several of the sample applications. The potentiometer and switch pins are 
described in Table 2-1 below. 
 

Reference Function MCU 
Signal (Port) Pin 

SW1 Connects to an IRQ input for user controls.  PB1_IRQ4_SW1 (PB1) 37 

SW2 Connects to an IRQ input for user controls. PE3_IRQ3_SW3 (PE3) 48 

RV1 Connects to an ADC channel for analog input. P40_ADPOT (P40, AN000) 60 

Table 2-1 Switch and Potentiometer Connections 
 
Four user LEDs are also included as described in Table 2-2 below. 
 

LED Colour Function MCU  
Port Pin 

LED0 Green User operated LED. P05 64 

LED1 Orange User operated LED. P41 58 

LED2 Red User operated LED. PB7 33 

LED3 Red User operated LED. PB6 34 

Table 2-2 LED Connections 
 
In order to use the LEDs and switches, the IDLE_VCC power rail must be activated, along with the POT_VCC 
power rail to operate the potentiometer (see section 2.4 for more information). 
 

2.2 USB Connectors 
 
Two USB connectors are included on the top of the RPB, CN1 and CN2, and connected to the USB pins on 
the RX111 (the USB connector on the bottom, CN8, is for the on-board debugger).  

CN1 allows the board to be used as a USB peripheral along with providing power to the board (for other 
power supply options, see section 2.4).  

CN2 can be used to connect USB peripherals such as flash drives, and the board will act as the host device. 
In order to operate as a host device, the IDLE_VCC power rail must be activated, and the bus switch IC4 must 
be enabled by driving MCU port P55 (pin 25) low (see the board schematics for more information).  
 

2.3 Expansion Headers 
 
Expansion headers provide access to spare MCU pins and further information about pin assignments may be 
found on page 5 of the board schematics. Some expansion pins are not available by default and require 
changes to 0Ω surface mount link resistors. Table 2-3 below shows the configuration changes available, by 
showing the path of a signal from the MCU on the left to a board function or header pin on the right. Default 
configuration is shown in bold, blue text.  
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Signal Name MCU Exclusive function Header connection 
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PC5_SCK1 PC5 29 PMOD-4 R106 R114 CN5-5 R114 R106 

P15_RXD1 P15 19 PMOD-3 R108 R111 CN5-6 R111 R108 

PC7_TXD1 PC7 27 PMOD-2 R105 R115 CN5-7 R115 R105 

PA0_LDOEN PA0 45 IC2-3 (LDO 
Enable) R61 R110 CN6-3 R110 R61 

PE1_AN009_TXD12 PE1 50 CN7-2 R118 R103 CN4-4 R118 R103 

PE2_AN010_VSUP PE2 49 Supply voltage 
monitor 

R154, 
R155 R156 CN4-5 R156 R154,

R155 

PE7_AN015_VCAP PE7 52 Supercapacitor 
voltage monitor 

R52, 
R56 R104 CN4-6 R104 R52, 

R56 
Table 2-3 Expansion header link resistor configuration 

 
In addition the board includes space for pull-up resistors on every MCU I/O pin, as shown on page 2 of the 
schematic, which are not used by any of the sample code but may be fitted by the user is needed. 
 
A Digilent PmodTM compatible connector can be fitted and used to interface with a variety of external 
peripherals, including the RSK Pmod display (not included in this kit). Some samples will use the display if 
connected. It will be necessary to fit a suitable 12-pin right-angle header, similar to Samtec SSW-106-02-T-D-
RA, to make use of the Pmod connector. The pinout of the Pmod connector is shown in Table 2-4. 
 

Pin Function Pin Function 
1 CS# 7 INT 
2 TXD/MOSI 8 RESET 
3 RXD/MISO 9 GPIO 
4 SCK 10 GPIO 
5 GND 11 GND 
6 VCC 12 VCC 

Table 2-4 Pmod Connector Pinout 
 
This board is not compatible with 5V-only Pmods and cannot supply 5V power, nor tolerate 5V logic input from an external 
peripheral. 

 
Header CN7 connects to a Cymbet Energy Harvesting evaluation kit (CBC-EVAL-09. This connector provides 
two-way communication with the Energy Processor for monitoring, as well as the power supply. The pinout of 
the energy harvesting connector is shown in Table 2-5. MCU port PA0 (pin 45) should be driven low to activate 
the power supply from the external harvesting kit, and disable the linear voltage regulator IC2.  
  

Pin Function 
1 RXD 
2 TXD 
3 NC 
4 GND 
5 VCC (input) 

Table 2-5 CN7 Energy Harvesting Connector Pinout 
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2.4 Power Supply 
 
Power for the RPB can be supplied from either USB connector CN1 or CN8, along with a supercapacitor or an 
energy harvesting evaluation kit connected to CN7. The board will use 5V USB power by default, falling back 
to the supercapacitor (boosted to 5V by a DC-DC converter) if this is unavailable and finally using the 3.6V 
energy harvesting board if connected. The power supply options, limitations and the order power sources are 
used if several are available are summarised in Table 2-6 below. 
 
Power Source Input Voltage 5V? 3.3V? J-Link Debugger? Priority 
J-Link USB (CN8) 5V Y Y Y 1 
USB Function (CN1) 5V Y Y N (Power off) 1 
Supercapacitor (C18) Up to 5V Y Y N (Power off) 2 
Energy Harvesting (CN7) 3.6V N Y (at 3.6V) N (Power off) 3 
E1 Connector 3.3V N Y N (Power off) 4 

Table 2-6 Power Supply Options 
 
Table 2-7 describes the MCU pins used for monitoring the power supply and shutting down board components 
for board current reduction. 
 

Signal Name MCU Purpose 
Port Pin 

P16_CHARGE_EN P16 18 Drive low to activate charging the supercapacitor. 
PE4_IDLE_EN PE4 47 Drive low to power up the IDLE_VCC rail (LEDs, switches, etc) 
P03_POT_EN P03 1 Drive low to power up the POT_VCC rail (potentiometer bias voltage) 
P55_VBUS_EN P55 25 Drive low to enable IC4 and operate USB host power supply (IC7)  
PE2_AN010_VSUP PE2 49 Measure the board supply voltage using ADC channel AN010. 
PE7_AN015_VCAP PE7 52 Measure the supercapacitor voltage using ADC channel AN015. 

Table 2-7 Power supply control pins 
 
Note: Charging the supercapacitor while using it to power the board will rapidly deplete the capacitor. 
 

2.5 On-board Debugger 
 
A SEGGER J-Link OB debugger is fitted on the bottom side of the RPB and can be used to debug the RX111 
MCU with e2 studio. For instructions to use the debugging features in e2 studio, refer to section 3. 
 
The J-Link debugger is enabled by default (JP2 not fitted).  Fitting JP2 will disable the J-Link debugger and is 
useful for reducing the supply current sourced through the USB connector CN-8. 

2.6 Current Measurement 
 
The debugger hardware incorporates a current measurement feature which can measure the current used by 
the RX111 MCU in various operating modes, which can be accessed and plotted using the ‘GUIDemo’ sample 
(see section 4).  
 
It is also possible to measure MCU current by removing R64 and fitting a multimeter across JP1. The current 
measurement circuit on the board will affect current readings taken with a multimeter, so the current 
measurement circuit should be disabled by setting switch SW3 to the OFF position. In this case the 
LowPowerDemo sample project should be used to perform the measurements. For detailed instructions 
please refer to section 2.7. 
 
Note: Ammeter readings taken while running the demo GUI will not be accurate due to interactions between the GUI and 
the current measurement circuit on the RPBRX111.  If Ammeter readings are required disable the current measurement 
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circuit by setting switch SW3 to the OFF position and use the LowPowerDemo sample project. 

 
Note: Do not set SW3 to the centre position as this will disconnect the RX111 MCU power supply. 

 
• The different power consumptions were measured under the peripheral states shown in the table below.   

An Agilent U1241B multi-meter (serial: MY51140128) was used to measure the power.  
• The results obtained cannot be guaranteed to be exactly the same for each board; but should not be 

significantly different. It is good to note that the result can be affected by the test environment and the 
equipment used.  

• Results are shown on the table below. 
 

 
 
 
 
 
 
 
 

2.7 Low Power Current Measurement Instructions 
 
The current consumption in various low power modes can be measured directly using an ammeter connected 
across JP1 and ensuring that R64 has been removed from the board. 
 

 
 
Ensure that SW3 is in the OFF position for this measurement to disable the debugger connections 
otherwise the lowest power readings will not be possible. 
 
Compile the Low Power Demo sample and download the sample code to the target.  Press ‘Resume’ to run 
the code to ensure that the device is programmed. Stop the debugger, disconnect the target connection and 
then disconnect the USB cable. 
 
Connect an ammeter across JP1 and select the mA range. Connect a mini-USB cable between CN8 and a 
PC. The LEDs (LED0 - LED3) will flash several times. 
 

• Clock Mode • Power Consumption 

•  • NORMAL 
MODE 

• SLEEP 
MODE 

• DEEP SLEEP 
MODE 

• SOFTWARE 
STANDBY 
MODE 

• HIGH SPEED • ~4 mA • ~1.2mA • ~800 uA • 0.4 uA 

• MIDDLE SPEED • ~2.3 mA • ~600 uA • ~500 uA (GUI) • 0.4 uA 

• LOW SPEED • 5 uA • 2.5 uA • n/a • n/a 
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The demo provides a menu which is navigated by the potentiometer RV1 adjusting the illuminated LEDs, and 
selected by pressing SW1. 
 
Select a menu item based on the following list by adjusting potentiometer RV1 then pressing SW1 to select. 
The corresponding value will be displayed on LEDs using binary as shown in the table below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* The following table is valid only if option “RTC_MENU” was selected. In this case the user should select a 
value for the RTC options from the table below. 

 
 
 
 
 
 
 
 
 
 
 

* Please note the LED Settings in this table are reversed. 
 
All other selections are for a clock mode.  LED0 will flash the selected number of times to confirm the 
selection. The menu operation will return to the main menu for the selection of a clock mode. 
 
After selection of a clock mode select the CPU load option in the same way by making a selection from the 
table below 

 
 
 
 
 
 
 
 
 

 
LED1 will flash the selected number of times to confirm the selection. 
 
At this point the CPU enters a full power loop in the selected mode. LED2 will be lit. At this point observe the 
MCU current to show what the operational current is. 
 

Menu LED Settings 

User Interface LED2 LED1 LED0 

(0) RTC_MENU * OFF OFF OFF 

(1) SUB_32k Clock Mode OFF OFF ON 

(2) LOCO_4M Clock Mode OFF ON OFF 

(3) HOCO_32M Clock Mode OFF ON ON 

(4) SW_SLEEP Clock Mode ON OFF OFF 

(5) DP_SLEEP Clock Mode ON OFF ON 

(6) SW_STBY Clock Mode ON ON OFF 

Menu LED Settings 

RTC_MENU LED0* LED1* LED2* 

(1) Output RTC OFF OFF ON 

(2) Reset RTC OFF ON OFF 

(3) Start RTC OFF ON ON 

(4) Stop RTC ON OFF OFF 

Menu LED Settings 

RTC_MENU LED2 LED1 LED0 

(1) CPU_MIN OFF OFF ON 

(2) CPU_TYP OFF ON OFF 

(3) CPU_MAX OFF ON ON 
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Press SW1 to put the CPU into the selected low power mode and again observe the MCU current 
measurement. At this point the low power mode has been activated. 
 
For the SUB_32k and SW_STBY modes the current will be in the order of micro Amps so it may be necessary 
at this point to switch the ammeter into the uA range.  
 
Caution:  In most Ammeters selection a very low current range introduces a larger series resistance which 

will produce a significant voltage drop once the current returns to the mA range. Some low cost 
meters may disconnect the processor current while changing modes. This can cause the CPU to 
be reset and prevent the correct measurement. 
In this case you can fit a jumper link across JP1 while changing range on the multi-meter. 

 
To exit the low power mode and restart, return the Ammeter to the mA range to avoid any possible overload of 
the meter and press the reset switch. 
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3.   Debugging with e2 studio 

3.1 Introduction 
e2 studio is an open source integrated development tool that allows the user to write, compile, program and 
debug a software product on many of the Renesas microcontrollers. 
 

3.2 Starting e2 studio and Importing Sample Code 
 
• Start e2 studio by selecting it from the 

Start Menu. The first dialog box to 
appear will be the Workspace Launcher. 

• Click ‘Browse’ and select a suitable 
location to store your workspace, using 
the ‘Create New Folder’ option as 
necessary. Click ‘OK’ 

 
 
 

• Click ‘Yes’ when presented with the 
‘Administrator Privilege’ dialog box. 

 
 
 

• The e2 studio welcome splash screen 
will appear. Click the ‘Go to the 
workbench’ arrow button on the far right 
(circled in the screenshot opposite). 
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• Once the environment has initialised, 
right click in the ‘Project Explorer’ 
window and select ‘Import…’ 

 
 

• The Import dialog box will now show. 
Expand the ‘General’ folder icon, and 
select ‘Existing Projects into 
Workspace’, then click ‘Next’. 
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• Choose ‘Select archive file’ and browse 
to the following file: 
 

C:\Renesas\Workspace\RPB\RX111\ 
Sample Projects\LowPowerFileCopy.zip 

 
• Click ‘Finish’ on the import dialog box to 

import the project. 

 
 
 

 

3.3 Build Configurations and Debug Sessions 

3.3.1 Build Configuration 
 
The e2 studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’. 
 
Release 
This build mode has optimisation turned on, and provides little debug information. The C code execution may 
appear to be out of order, due to the way compiler optimises the code. This build configuration is intended for 
final ROM-programmable code. 
 
HardwareDebug 
This build mode has all optimisation turned off, and provides full debug information. This is the best 
configuration to use whilst developing code as C code execution will be linear. 
 
• Click the top level ‘LowPowerFileCopy’ 

folder and then go to the arrow next to 
the build button (hammer 
icon), and select the 
‘HardwareDebug’ option. 

 
• e2 studio will now build the code. 
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3.3.2 Debug Configuration 
 
• Click the arrow next to the 

debug button (bug icon). 
Select ‘Debug 
Configurations’.  

 
 

• The ‘Debug Configurations’ dialog box 
will appear. Click the small arrow next to 
the ‘Renesas GDB Hardware 
Debugging’ option. 

• The debug configurations for each 
project will appear. Select the entry for 
the ‘LowPowerFileCopy’ project. 

 
 

• The debug configurations control page 
will then show for the project. Change 
the main tab to ‘Debugger’ and then 
select ‘Connection Settings’ on the 
secondary tab bar that appears. 

• There is no need to change the 
debugger settings as they are 
preconfigured with the project, however 
feel free to review the settings provided. 

 
 

 
• Click the ‘Debug’ button to continue. 

e2 studio will now connect to the 
debugger and download the code to the 
target. 
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• After downloading the code a dialog box 
will appear asking if you would like to 
switch to the ‘Debug perspective’. Click 
‘Remember my decision’ to prevent this 
dialog box from appearing in future, 
then click ‘Yes’ 

• e2 studio will load the new perspective, 
which is optimised for debugging. 
 

 
 

• To change back to the default ‘C/C++’ 
perspective, from the menu bar select 
Window > Open Perspective > Other 

• The ‘Open Perspective’ dialog box will 
appear. Click on the desired perspective 
to select it then ‘OK’. 

 
 

• Alternatively, click on the button with the 
double arrow in the top right corner of 
the screen, as shown opposite, and 
select the ‘C/C++’ option that appears. 

 
 

 
 

3.3.3 Running the Demo  
 
• Each sample includes a Description.txt file detailing the sample’s operation and any configuration 

required. 
• Once the code has been downloaded, click ‘Resume’ to run the code to the main function, then click the 

‘Resume’ button again to run the rest of the code. 
• It is recommended that you run the sample once before continuing with this tutorial. Detailed instructions 

for operation of the sample are given in the Description.txt file. Note however that the USB cable should 
not be unplugged from CN8 as this will disable the debugger. 
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3.4 Reviewing the Sample Code 
 
This section will give a brief overview of some of the demo code and describe basic debugging functionality 
using e2 studio. For more information on the USB Host library that the demo is built around, review the USB 
HMSC application note (R01AN0624EJ) available from the Renesas website.  
 

3.4.1 Program Initialisation 
 
Before the main program can run, the microcontroller must be configured. The following parts of the tutorial 
program are used for initialising the RPB device so that the main function can execute correctly. The 
initialisation code is run every time the device is reset via the reset switch or from a power cycle. 
 
• Intially the microcontroller will start in 

the PowerON_Reset_PC() function, 
from which the initialisation and main 
functions are called. 

• Click the ‘Step Over’ button (or 
press [F6] twice) to step to the 
usb_cpu_mcu_initialize() line. 

 

 
 

• Click the ‘Step Into’ button (or 
press [F5]) to enter the 
function. 

 
• This function configures the oscillators 

and clock dividers. A summary of the 
clock speeds may be found in the 
function comments. 

• The user can step through this 
initialisation code by clicking the ‘Step 
Over’ icon, but for the purpose of this 
manual it will be skipped. 

• Click the ‘Resume’ button (or 
press [F8]), to run the code up 
to the main function. 

 
 
 
 
 
 
 
 
 
For further details regarding hardware configuration, please refer to the RX111 Group Hardware Manual. 
 
It is possible that line numbers for source code illustrated in this document do not match exactly with that in 
the actual source files. It is also possible that the source address of instructions illustrated in this manual differ 
from those in user code compiled from the same source. 
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3.4.2 Main Functions 
 
This section will look at the program code called from within the main() function, and how it works. 
 
• Double-click in the left-hand column to 

set a breakpoint on the ‘while (1)’ line 
inside the main function. This will be 
used later in the tutorial. 

Note: The alternative to the above method 
requires reverting back to the default 
‘C/C++’ perspective.  

Whilst in the C/C++ perspective, set the 
mouse cursor on the instruction, then 
from the menu bar select Run > Toggle 
Breakpoint. 

• Click ‘Step Into’ (or press [F5]) to enter 
the usb_hmsc_task_start() function. 
 

 

• Select the usb_cpu_target_init() function 
call and press [F3] (or right-click and 
select ‘Open Declaration’. The 
usb_cpu_target_init() function will open.  

  
 

• First select and then right-click on the 
line ‘CHARGE_ENABLE_PDR = 0x1u’ 
and select ‘Run to Line’ to execute the 
program up to this point. The board 
LEDs and voltage measurement ADC 
inputs will be configured. 

• The following lines set the 
supercapacitor charge enable pin into 
open-drain mode and drives it low to 
charge the capacitor. The LEDs and 
USB bus switch are also activated. For 
more information on hardware 
configuration, see section 2. 

 
 

 

• In the ‘Outline’ view on the right-hand-
side, click on the function 
‘Excep_CMT1_CMI1’ 

• Set a breakpoint on the first line in the 
function. 

• Click the ‘Step Return’ button 
(or press [F7]) to run to the end 
of the current function and 
return to the caller. 

• Click the ‘Resume’ button to continue 
running the code. 
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• Execution will stop on the breakpoint at 
the start of ‘Excep_CMT1_CMI1()’. This 
is an interrupt handler for a periodic 
timer started in the 
‘usb_cpu_target_init()’ function. 

• This function reads the power supply 
and supercapacitor voltages, and uses 
these values to enable/disable charging 
when the external power supply is 
connected/disconnected, and to operate 
the LEDs and display the current charge 
state. 

• Remove the breakpoint by double-
clicking the blue circle in the left-hand 
column. 

• Click the ‘Resume’ button to continue 
running the code. The microcontroller 
will enter a low power sleep state.  

 
• Plug in a USB memory stick. An 

interrupt will wake the microcontroller 
and execution will stop at the breakpoint 
in the main function. 

• Select and then right-click on the 
function ‘usb_hmsc_SampleAplTask()’ 
and click the ‘Run to Line’ menu option. 
Click ‘Step In’ to enter the function.  

 
 

• This function checks for incoming 
application messages, and processes 
them to mount the USB memory stick, 
copy a file and then unmount it, before 
entering software standby mode. 

• Click ‘Resume’ to copy the file and 
complete the sample. 

 
 

• Click the ‘Suspend’ button to halt 
program execution. This is the extent of 
the tutorial code.  
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4.   Demonstration GUI 

A ‘GUIDemo’ sample is included in the sample set, and connects to an application running on a PC to control 
the RX111 operating mode and measure power usage of the device. This section will describe how to use the 
GUI to demonstrate the low-power characteristics of the microcontroller. 
 
• First, follow the steps in sections 3.2 and 3.3, substituting ‘GUIDemo’ for ‘LowPowerFileCopy’ to prepare 

the sample code in e2 studio and download it to the board.  
• Once this process has completed, stop the debugger in e2 studio and power cycle the board. 
 
• Launch the demo GUI, 

either by double-clicking the 
‘YRPBRX111 Demo’ 
desktop shortcut or using 
the Start menu. 

  
 

• The demo GUI should start 
with the ‘Home’ tab active 
as shown oppsoite. Click 
‘Connect’ to connect with 
the RPB. 

• After a few seconds the 
message in the status bar 
at the bottom of the window 
will change to show the 
RTC time reading from the 
RPB and the red circle in 
the bottom-right corner will 
go green. 

• Use the ‘Sync’ button to set 
the RPBRX111 RTC with 
the host computer system 
time. 

• A monitoring console to 
show communication 
between the PC and the 
RPB can be opened by 
clicking the arrow in the 
window corner. 

  
 

• Click on the ‘Power 
Measurement’ tab.  

• This tab accesses the 
current measurement circuit 
on the RPB, and displays 
current measurements 
taken from the MCU. 

• Click the ‘Start’ button to 
begin taking 
measurements. Data will 
appear on the graph, with 
time on the horizontal axis 
and current (in µA) on the 
vertical. The axis will scale 
automatically. 
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• Click on the ‘Low Power’ 

tab. 
• This tab provides controls to 

change the speed mode 
(and clock source) of the 
RX111 MCU, along with 
access to sleep modes. 

• By default, the system clock 
uses the 12MHz crystal 
oscillator and the PLL 
circuit. 

• In middle-speed mode the 
high-speed on-chip 
oscillator (HOCO) will be 
selected as the clock 
source and the crystal 
oscillator shut down.  

• In low-speed mode the 32.768kHz subclock will be selected as the clock source and all other clocks will 
be disabled. Note that when low-speed mode is selected, it is not possible to put the RX111 into any of the 
sleep modes. 

• Switch back to the ‘Power Measurement’ tab after changing clock source to observe the effect on the 
MCU current. It may be necessary to stop, clear, and restart the graph when using sleep modes, as the 
reduction in current is significant. 



RPBRX111  5.   Code Development 
 
 

R20UT2699EG0100 Rev. 1.00  Page 25 of 32 
Jul 09, 2013  

5.    Code Development 

5.1 Overview 
 
For all code debugging using Renesas software tools, the RPB board must be connected to a PC via a USB 
cable plugged in to the on-board debugger (connector CN8).  
 
The on-board debugger can only be used with the RX111 on the RPB, and is not designed for user system 
development. A Renesas Starter Kit is available for this device which contains an E1 debugger for use with 
user hardware. 

5.2 Compiler Restrictions 
 
The compiler supplied with this RPB is fully functional for a period of 60 days from first use. After the first 60 
days of use have expired, the compiler will default to a maximum of 128k code and data. To use the compiler 
with programs greater than this size you need to purchase the full tools from your distributor. 

5.3 Mode Support 
 
The RX111 microcontroller only supports single-chip operating mode. 
 

5.4 Debugging Support 
 
The on-board J-Link debugger supports a variety of debugging features, some of which are described in the 
‘AdvancedDebugDemo’ sample provided. Further documentation is available from the SEGGER 
Microcontroller website. 
 
It is also possible to debug the RX111 using a Renesas E1 Emulator, by fitting a 14-pin shrouded box header 
to the connector labelled ‘E1’ on the underside of the RPB. No other modification is necessary however the J-
Link OB and E1 should not be used at the same time.  
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5.5 Address Space 
 
Figure 8-1 below details the address space of the MCU. This diagram is taken from the Hardware Manual 
version 0.2. The MCU fitted to the RPB has 32KB of ROM. For further details, refer to the RX111 Group 
Hardware Manual. 
 

 
Figure 5-1: MCU Address Space Diagram 
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6.  Troubleshooting 

Can’t Connect the J-Link Debugger to the RX111 
 
Driving PA0_LDOEN low will turn off the Power Supply to the RX111. If this is done without supplying power 
through VCC_HARVEST on CN7 pin 5, then there will be no power applied to the RX111 and the J-Link 
debugger will not be able to communicate with the RX111. 
 
To recover a board in this state either: 
 

1. Supply 3.6V through VCC_HARVEST on CN7 pin 5, or 
2. Remove R61 from the reverse side of the board as indicated below. 

 
 

 
 

Figure 6-1: Location of R61 
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7.   Additional Information 

Technical Support 
For details on how to use e2 studio, refer to 
the help file by opening e2 studio, then 
selecting Help > Help Contents from the 
menu bar. 

 

 
Parts of the sample code provided with the RPBRX111 can be reproduced using the ‘Application Leading 
Tool’ (Applilet) code generator tool. Applilet4 is included on the DVD.  
Source files and functions generated by Applilet4 are prefixed with ‘r_’ and ‘R_’, respectively.  
 
Applilet4 for the RX111 is a code generation tools to assist you in creating a template for a project that will 
assist you in initial configuration of the microcontroller. Applilet4 will be integrated into e2 studio with version 
2.1. User's working with IAR tools will still need to you the stand-alone application to generate the base code 
project as the e2 studio built-in version will not generate code for IAR. 
 
For information about the RX111 series microcontrollers refer to the RX111 Group Hardware Manual. 
 
For information about the RX assembly language, refer to the RX Series Software Manual. 
 
Technical Contact Details 
 
Please refer to the contact details listed in section 10 of the “Quick Start Guide” 
 
General information on Renesas Microcontrollers can be found on the Renesas website at: 
http://www.renesas.com/ 
 
 
Trademarks 
All brand or product names used in this manual are trademarks or registered trademarks of their respective 
companies or organisations. 
 
 
Copyright 
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of 
this document, either in whole or part is prohibited without the written permission of Renesas Electronics 
Europe Limited. 
 
© 2013 Renesas Electronics Europe Limited. All rights reserved. 
© 2013 Renesas Electronics Corporation. All rights reserved. 
© 2013 Renesas Solutions Corp. All rights reserved. 
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